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Labaratory 1 
 

 ใหนักศึกษาทำแผนที่จำนวนประชากรของประเทศ 10 ประเทศดังตอไปน้ี 
สหรัฐอเมริกา / จีน / อินเดีย / ญี่ปุน / ไทย / สหรัฐอาหรับเอมิเรตส / บราซิล / แอฟริกาใต / รัสเซีย / 
อียิปต โดยตองการใหแสดงเปนแผนท่ีแบบ Bubble map (ดังภาพที่แสดง)  
โดยมีองคประกอบของแผนที่ประกอบดวย ทิศ / ชื่อแผนท่ี / ชื่อ-สกุล และรหัสผูจัดทำ 
 
สิ่งที่ใช  
 1.โปรแกรม microsoft excel 
 2.โปรแกรม microsoft powerpoint 
 3.Google map 
 4. worldometers 
ขั้นตอนการทำแผนท่ี 
*นำเขาขอมูลและสรางตาราง* 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. เปดโปรแกรม microsoft excel > 
สรางหัวตารางช่ือประเทศ ละตจิูด 
ลองจิจูด จำนวนผูติดเชื้อ 

2.คัดลอกช่ือประเทศและจำนวนผูติด
เชื้อโควิด 19 ในแตละประเทศจากเว็บ 
worldometers มาวางไวในตาราง 

3.หาพิกัดของแตละประเทศโดยการ
ไปท่ี Google map เลื่อนไปหา
ประเทศท่ีตองการ > คลิกขวาท่ี
ประเทศนั้น ขอมลูจะขึ้นดังภาพ >
คัดลอกพิกัดออกมาวางในตารางให
ครบทุกประเทศ 
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*สรางแผนที่แบบ Bubble map* 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 

4.คลุมดำขอมลูตัวเลขละตจิูด 
ลองจิจูด และจำนวนผูติดโควิด 19 
> แทรก > แผนภูมิฟอง  จะได
แผนภูมิแรกเริม่ดังภาพ 

5.เอาช่ือแผนภูมิออก เนื่องจาก
ตองการแคแผนท่ี สวนช่ือจะไป
สรางใหม > คลิกท่ีเครื่องหมาย + 
ขวาบนของแผนภูมิ คลิกช่ือ
แผนภูมิออกไป 

6.แกไขแผนภมูิ คลิกไปท่ี
ออกแบบ > เลือกขอมูล > แกไข  

-ใหคา X เปนลองจิจูด คลุมดำขอมูลตัวเลขลองจิจดูทั้งหมด 
-คา Y เปนละติจูด  
-ขนาดฟองในขอมูล เปนจำนวนผูติดเช้ือโควิด  
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7.ตั้งคาแกน คลิกขวาไปท่ีแกนท่ีตองการปรับ > จัดรูปแบบแกน > 
-แกนแนวต้ัง คาต่ำสุด -90 คาสูงสดุ 90   
-แกนแนวต้ัง คาต่ำสุด -180คาสูงสุด 180 

8.เพิ่มพื้นหลังเปนรปูแผนท่ีโลก คลิกซายสองครั้งท่ีแผนภมูิ จะได
เครื่องมือดังภาพดานขวา > เลือกเติมรปูภาพหรือพื้นผิว > insert 
> เลือกรูปภาพท่ีโหลดไวในเคร่ืองแลวหรือคนหารูปภาพใน
อินเตอรเนต็ กดตกลง จะไดแผนทีอ่อกมาดังภาพ 

9.เพิ่มปายชื่อขอมูล คลิกที่ฟองขอมูล > เพิ่มปายช่ือ > คลิกขวาท่ี
ฟองขอมูล > จัดรูปแบบปายช่ือขอมูล > เลือกขนาดฟอง คาจาก
เซลล และแสดงเสนโยงจากแผนภมูิไปปายช่ือ 

แสดงช่ือประเทศ กดเลือก
คาจากเซลล กดคลุมดำ
ทั้งหมดที่ช่ือประเทศ ตกลง  

จะแสดงจำนวนผูตดิเช่ือโควิด 19 

ตองคลิกซายไปท่ี
ปายช่ือ และลากไป
ที่อ่ืน เสนถึงจะข้ึน
ออกมาใหเห็น 
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10.เปลี่ยนสจีุดของมูล(ฟอง) > คลิกซายท่ีฟองสองคร้ังหางกันเล็กนอย
ใหเลือกฟองอันเดียว > คลิกขวา > จัดรูปแบบจุดขอมูล > เลือกถังสี > 
เติมแบบทึบ > เลือกสีที่ตองการ ทำแบบน้ีทุกจุด ก็จะไดแผนท่ีดังภาพ 

11. เพิ่มองคประกอบของแผนท่ี > คัดลอกแผนที่ท่ีสรางเสร็จแลว วาง
ไวท่ี โปรแกรม microsoft powerpoint > เพิ่มชื่อแผนท่ี ทิศเหนือ 
และช่ือผูจดัทำ > คลิกท่ีกลองขอความและพิมพช่ือแผนท่ีและช่ือ
ผูจัดทำ > จัดวางใหสวยงาม > เพิม่ทิศ ไปท่ีแทรก รูปราง เลือก
สามเหลี่ยม ใสสดีำ จัดวาง  

12.บันทึกแผนที่เปนรูปภาพ > ไปที่
ไฟล > บันทึกเปน > เลือกนามสกลุ
ไฟลเปน JPAG > บันทึก ก็จะไดไฟล
แผนที่เปนภาพ 

แผนที่แบบ Bubble map ที่สำเรจ็แลว 

แผนท่ีท่ีได 
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Labaratory 2 
 

ใหนักศึกษาทำแผนที่ พรอมแสดงรายละเอียดจากขอมูลที่สงให พรอมทั้งอธิบายเหตุผลประกอบการใช
สัญลักษณตาง ๆ ในแผนที่ โดยละเอียด 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 จากแผนที่แสดงตำแหนงตลาดและหางสรรพสินคาในกรุงเทพมหานคร ใชสัญลักษณรูปรถเข็นสีน้ำเงิน
แทนหางสรรพสินคาและตะกราสีแดงแทนตลาด ซึ่งเปนสัญลักษณประเภทจุด เพราะท่ีตั้งหางสรรพสินคาและ
ตลาดเปนตำแหนง มักจะใชสัญลักษณประเภทจุดในการแสดงตำแหนง จุดรูปรถเข็นแทนหางสรรพสินคา 
เนื่องจากเวลาไปใชบริการหางสรรพสินคามักจะใชรถเข็นในการเลือกซื้อสินคา จุดรูปตะกราแทนตลาด
เนื่องจากเวลาไปตลาดมักจะเลือกเดินซื้อสินคาโดยใชตะกราถือใสสินคา เลือกใชสีน้ำเงินและสีแดง เพื่อให
สัญลักษณมีสีที่แตกตางกันกับพื้นหลังและระหวางสัญลักษณดวยกันอยางชัดเจน  
 ใชสัญลักษณเสนทึบแทนขอบเขตการปกครองแตละแขวงในกรุงเทพมหานคร เพื่อแสดงขอบเขตการ
ปกครองแตละแขวง ใสชื่อเพ่ือบอกชื่อของขอบเขตแขวงนั้น 
 เขตกลุมการปกครองใชสัญลักษณประเภทพื้นที่ เพราะใชแสดงขอบเขตของพื้นที่ของขอมูล และใชสี
เพ่ือแสดงความแตกตางของแตละพ้ืนที่ ไมใสชื่อกลุมการปกครองของกรุงเทพมหานครแตละกลุมเพ่ือไมใหแผน
ที่ดูไมสบายตา แตใชคำอธิบายสัญลักษณอธิบายแตละสีวาเปนกลุมการปกครองที่ใดแทน 
 ใชพื้นหลังของขอมูลพ้ืนที่กรุงเทพมหานครเปนพ้ืนที่จังหวัดขางเคียง เพ่ือแสดงตำแหนงที่ตั้งสัมพันธที่
อยูบริเวณโดยรอบกรุงเทพมหานคร ทำใหพื้นหลังสีจางกวาเพ่ือเนนแผนที่ที่ตองการแสดงใหเดนมากยิ่งขึ้น 
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 ชื่อของแผนท่ีวางไวในตำแหนงก่ึงกลางดานบน เพ่ือใหเห็นชื่อแผนท่ีอยางชัดเจน 
 ทิศเหนือ วางไวดานบนซายของแผนท่ี เพ่ือบอกทิศ ใหมีอักษรตัว N แสดงเปนทิศเหนือ 
 ขอบระวางแผนท่ีใชแบบสลับขาวดำและบอกพิกัด เพื่อใหทราบตำแหนงพิกัดของพ้ืนที่ในแผนที่ 
 คำอธิบายสัญลักษณ เพ่ืออธิบายสัญลักษณในแผนที่ ไวตำแหนงขวาลาง เนื่องจากบริเวณนี้แสดงที่ตั้ง
สัมพันธรอบกรุงเทพมหานคร ซึ่งไมใชพ้ืนที่หลักท่ีตองการแสดงในแผนที่ 
 มาตราสวน 1 : 300,000 เพ่ือใหแสดงแผนท่ีไดครอบคลุมพ้ืนที่กรุงเทพมหานครท้ังหมด และยังแสดง
พ้ืนที่รอบ ๆ ดวย 
 ชื่อผูจัดทำและวันที่จัดทำแผนที่ เพื่อแสดงผูจัดแผนท่ีและวันที่จัดทำแผนท่ี 
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Laboratory 3 
 
1.สรางเสนชั้นความสูง (Contour) และแผนที่เสนชั้นความสูง จากขอมูลที่กำหนดให 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1.นำเขาขอมูล ไปที่ Layer > Add 
layer > Add raster layer 

2.เลือกขอมูล ไปที่ Raster > Raster dataset 
> กดตรงจุดสามจุด(...) ดานขวา > ไปที่เก็บ
ไฟล > เลือกไฟลนามสกุล DEM 

จะแสดงผลดังนี้ 
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3.สรางเสนชั้นความสูง ไปที่ Raster > 
Extraction > Contour 

4.ตั้งคาเสนชั้นความสูง  
-Input layer ขอมูลที่จะแปลงเปน
เสนชั้นความสูง  
-Interval between contour 
lines ระยะหางระหวางเสนชั้น
ความสูง (ในที่นี้ตั้งคาเสนชั้นความ
สูงหางเสนละ 20 m.) > Save to 
file > บันทึกเปนไฟล .shp 
 

จะแสดงผลดังนี้ 
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5.ใสคาเสนชั้นความสูงหลัก ไปที่ properties > labels >single labels > value เลือก ELEV  

6.ใสใหปายชื่ออยูกลางเสน
ชั้นความสูง ไปที่ 
placement > allowed 
position เลือก on line  

7.ใสกรอบใหปายชื่อ เพ่ือให
เห็นตัวเลขไดชัด มองงาย ไป
ที่ buffer และกด OK 

ผลลัพธ 

ตัวเลขจะอยูตรงกลางเสนชั้นความสูง 
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8.เพิ่มคอลัมน เพ่ือแยก
ขอมูลเสนชั้นความสูงหลัก
และเสนชั้นความสูงรอง ไป
ที่ open attribute table 
> open field calculator 
> outpute field name 
ตั้งชื่อหัวคอลัมน > เขียน
โคด > if(“ELEV”%100=0 
, 1 , NULL”) > OK 
*บันทึกท่ีตารางขอมูลดวย
ซายบน 

ผลลัพธ 
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9.เปลี่ยนสัญลักษณในแผนที่ไปใชอีกขอมูล 
ไปที่ symbology > catagorised > value 
เลือก Index > ปรับแตงสี ใหเสนชั้นความสูง
หลักหนาและเขมกวาเสนชั้นความสูงรอง > 
OK 

10.สรางคอลัมนในตารางขอมูลเพิ่ม เพ่ือใช
สำหรับใหปายชื่อแสดงแตขอมูลของเสนชั้น
ความสูงหลัก ไปท่ี open attribute table 
> open field calculator > outpute 
field name ตั้งชื่อหัวคอลัมน > เขียนโคด 
>”Index”*”ELEV” > OK 

หมายเหตุ คอลัมน index ที่สรางกอนหนา มี
ขอมูลคาคือ 0 , 1 ไปคูนกับ ELEV (คาเสน
ชั้นความสูง) จะทำใหกำจัดขอมูลเสนชั้น
ความสูงรองออกไปเปนไมมีคา สวนเสนชั้น
ความสูงหลักจะมีคาเทาเดิม เวลาแสดงใน
ปายชื่อจะแสดงขอมูลเสนชั้นความสูงหลัก
อยางเดียว 

ผลลัพธ 

หลัก 

รอง 
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11. ทำใหปายชื่อแสดงแตคาของเสนชั้น
ความสูงหลัก ไปท่ี labels > value 
เปลี่ยนเปน label (คอลัมนที่สรางที่
ตารางขอมูลกอนหนา)  

ผลลัพธ 

กอน หลัง 

แสดงคาเสนชั้นความสูงทุกเสน แสดงเฉพาะคาของเสนชั้นความสูงหลัก 

12.ทำแผนที่และใส
องคประกอบของแผนที่ 
จะไดดังภาพ  
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2.การจัดทำแบบจำลองความสูง 3 มิติ (3D) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
  
 
 
 
 
 
 
 
 
 
 
 
  

1.สรางแผนที่ 3 มิติ ไปท่ี Viwe > 
New 3D Map view  

จะแสดงผลดังนี้ 

รูปภาพ DEM 

2.ตั้งคาการแสดงผล ไปที่ รูปประแจ  

3.ตั้งคา 
-Type = DEM 
-Elevetion = เลือกไฟลที่เราจะทำ 
-vertical scal = สเกลความสูงในแนวด่ิง 
ยิ่งใหคามากจะยิ่งตางจากคาความเปนจริง 
แสดงใหเห็นความสูงลักษณะภูมิประเทศ
ชัดเจน 
-Tile resolution = คาความละเอียด ยิ่ง
มากย่ิงเนียน 
-Skir height =  
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ภาพที่ไดจากการตั้งคา 
ให Tile resolution = 16 , Skir height = 10 เทากันทุกรูป แตเพ่ิมคา vertical scal 

vertical scal = 1 
Tile resolution = 16 
Skir height = 10 

vertical scal = 5 
Tile resolution = 16 
Skir height = 10 

vertical scal = 10 
Tile resolution = 16 
Skir height = 10 

vertical scal = 15 
Tile resolution = 16 
Skir height = 10 

จากภาพ 3 มิติ ทั้ง 4 รูป ที่เปลี่ยนคา vertical scal จะเห็นวายิ่งเพ่ิมคา vertical scal ความสูงก็จะ
ยิ่งเพ่ิมมากข้ึน แตในพ้ืนที่ที่ระดับความสูงเปน 0 เมตร ไมไดมีความสูงเพ่ิมข้ึนเลยทุกภาพ ทำใหพื้นที่
มีความสูงกับพ้ืนที่ที่มีความสูงเปน 0 มีความสูงแตกตางกันมากกวาความเปนจริง ดังนั้นควรใสคา 
vertical scal ไมใหสูงเกินไป 
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vertical scal = 5 
Tile resolution = 20 
Skir height = 10 

vertical scal = 5 
Tile resolution = 25 
Skir height = 10 

vertical scal = 5 
Tile resolution = 10 
Skir height = 10 

vertical scal = 5 
Tile resolution = 5 
Skir height = 10 

ภาพที่ไดจากการตั้งคา 
ให Tile resolution = 16 , Skir height = 10 เทากันทุกรูป แตเพ่ิมคา vertical scal 
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vertical scal = 5 
Tile resolution = 20 
Skir height = 0 

vertical scal = 5 
Tile resolution = 20 
Skir height = 20 

vertical scal = 5 
Tile resolution = 20 
Skir height = 30 

vertical scal = 5 
Tile resolution = 20 
Skir height = 40 

ภาพท่ีไดจากการตั้งคา 
ให Tile resolution = 16 , Skir height = 10 เทากันทุกรูป แตเพ่ิมคา vertical scal 
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4.บันทึกภาพ 3 มิติ ไปที่ รูปหกเหลี่ยม
สามสี > ตั้งชื่อ > เลือกที่อยูไฟล > OK  

จะไดไฟลนามสกุล OBJ ตองใชโปรแกรมดูภาพ 3 มิติเทานั้นถึงจะเห็น ดังภาพ 

จะไดหนานี้ 

จะไดไฟลนามสกุล OBJ ตองใชโปรแกรมดูภาพ 3 มิติเทานั้นถึงจะเห็น ดังภาพ 
จากภาพตั้งคา vertical scal = 5 เพราะความสูงพ้ืนที่จะไดไมแตกตางจากความเปนจริง
มาก พ้ืนที่ที่มีความสูง 0 เมตร และพ้ืนที่ที่สูงมากกวา 0 เมตร ไมมีระดับความสูงรูปทรง
แตกตางกันมากจนเห็นไดชัด 
Tile resolution = 20 ใหความละเอียดในตารางเพ่ิมจากคาที่ตั้งใหตอนแรก เพ่ือใหมี
ความละเอียดและภาพเนียนข้ึน และไมทำใหเครื่องคอมพิวเตอรทำงานมากเกินไป 
Skir height = 30  
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ภาพตัดขวางจากการทำเสนชั้นความสูง 
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Laboratory 4 

 การเก็บขอมูลและแสดงผลขอมูลจากภาพถาย ดวยขอมูลที่ระบุพิกัด (Geo-tagging) 
อุปกรณ 
 1.ภาพถายที่มีตำแหนงพิกัด 
 2.โปรแกรม QGIS 
วิธีทำ 
 1.ดาวโหลดภาพถายที่มีตำแหนงพิกัดมา >  เปดโปรแกรม QGIS > ไปที่ Processing > Toolbox > 
คนหาวา Geotag เลือก Import Geotagged photos 

 
 2. คนหาโฟลเดอรที่เก็บภาพถายไว > เลือก โฟลเดอรภาพถาย  
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 3.ไปที่ save as file เพ่ือเลือกสถานที่บันทึก 

 

 4.จะไดตำแหนงพิกัดจำภาพดังน้ี ยังไมมีภาพปรากฏมา 
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 5.ไปที่ Web > QuickMap > OSM > OSM standart เพ่ือท่ีจะทำเขาภาพพ้ืนหลังที่เปนภาพถาย
ดาวเทียมมา 

 

 6.ไดแผนที่พ้ืนหลังพรอมกับตแหนงพิกัดของภาพท่ีปรากฏบนแผนที่ 
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 7.นำเขาภาพถายไปยังแผนที่ ไปที่ Import photos > เลือกโฟลเดอรภาพถาย > เลือกสถานที่บันทึก 
> OK 

 

 8.แท็บ layer คลิกไปที่ ตำแหนงพิกัดของภาพ > ปรับแตงสัญลักษณจุดเพ่ือความสวยงาม 
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 9.จะไดแผนที่ตำแหนงพิกัดภาพดังน้ี 

 

 เมื่อคลิกไปที่ตำแหนงก็จะปรากฏภาพถายออกมา
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 10.นำแผนทีที่ไดไปทำแผนที่ที่มีสวนประกอบของแผนที่ใหครบ ไดดังนี้ 

 
องคประกอบของแผนที่แสดงตำแหนงพิกัดจากภาพถาย 
 1.ชื่อแผนท่ี ใสเพื่อจะไดทราบวาแผนที่นี้จัดทำเกี่ยวกับอะไร วางตำแหนงไวตรงกลางและขนาด
ตัวอักษรใหญเพ่ือจะไดมองเห็นไดเดนชัด   
 2.ทิศเหนือ เพ่ือแสดงทิศทาง และวางไวดานซายเพื่อไมใหทับกับเนื้อหาในแผนท่ี 
 3.ตัวของแผนที่และพ้ืนหลัง มีพ้ืนหลังเพ่ือแสดงใหเห็นวาตำแหนงจุดของภาพในแผนที่อยูบริเวณไหน
ของโลก ถามีแคขอมูลตำแหนงพิกัดของภาพถายก็จะไมสามารถวาภาพถายนั้นอยูบริเวณใดของโลก เลือกพ้ืน
หลังนี้เพ่ือไมใหพ้ืนหลังเดนไปกวาจุดพิกัด 
 4.ขอบระวางและพิกัดทางภูมิศาสตร เพ่ือใหทรายถึงตำแหนงทางภูมิศาสตรของจุดตำแหนงพิกัด
ภาพถาย 
 5.รูปภาพโลโกตรามหาวิทยาลัยราชภัฏสวนสุนันทา เพื่อใหทราบวาหนวยงานไหนเปนผูจัดทำแผนที่ 
 6.คำอธิบายสัญลักษณของแผนที่ เพื่อใหทราบความหมายของสัญลักษณในแผนที่วาบงบอกถึงอะไร  
 7.มาตราสวนคำพูด เพ่ือแสดงมาตราสวนเปนตัวอักษรและตัวเลข 
 8.มาตราสวนบรรทัด เพื่อแสดงมาตราสวนเปนเสน 
 9.ชื่อผูจำทำแผนที่ เพื่อใหทราบวาใครเปนผูจัดทำแผนที่ 
 10. วันที่จัดทำแผนที่ เพื่อใหทราบวาแผนที่จัดทำขึ้นเมื่อใด   
 ตั้งแตโลโกตรามหาวิทยาลัยจนถึงวันที่จัดทำ วางไวตำแหนงดานขวาของแผนท่ีเพ่ือใหดูเปนระเบียบ
และไมบังขอมูลที่แสดงในแผนที่ ในแผนที่จะแสดงเพียงตำแหนงของรูปภาพเทานั้น จะไมแสดงรปูภาพ 

 

1 

2 

4 

5 

6 

7 

8 

9 

10 

3 
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Laboratory 5 
 

ขอมูลที่ตองใช 
 1.โปรแกรม QGIS 
 2.ขอมูลเสนชั้นความสูงที่มีระยะหาง 20 เมตร 
 3.ขอมูลเสนแนวรองน้ำ 
 4.ขอมูลเสนแนวสันเขา 
 5.ขอมูลจุดตำแหนงหมูบานในรัศมี 10 กิโลเมตร 
 6.ขอมูลขอบเขตตำบลที่อยูในเขตรักษาพันธุสัตวปาเขาสอยดาว 
 8.แบบจำลองระดับสูงเชิงเลข 
 
วิธีทำ 
 1.นำเขาขอมูลทั้งหมดที่ตองใชมาในโปรแกรม QGIS ไปที่ Layer > Add Layr >Add vecter layer  
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 2.ปรับแตงขอมูลขอบเขตตำบล คลิกขวาท่ีตัวขอมูล ไปที่ properties > Symbology > 
categorized > value = T_NAME_T (ชื่อคอลัมนขอมูลตำบลภาษาไทย) > Classify > เลือกทั้งหมด > 
symbol > เอาแตเสนกรอบ ไมเอาพ้ืนหลัง > OK 

 
 3.ใชชื่อตำบล คลิกขวาที่ตัวขอมูล ไปท่ี properties > Labels > single labels > value = 
T_NAM_T > ปรับขนาดและฟอนตตามตองการ > OK 
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 4.ปรับแตงขอมูลเสนแนวรองน้ำ คลิกขวาที่ตัวขอมูล ไปที่ properties > Symbology > single 
symbol > ปรับสีและขนาดตามท่ีตองการ > OK 

 
 5.ปรับแตงขอมูลเสนแนวรองน้ำ คลิกขวาที่ตัวขอมูล ไปท่ี properties > Symbology > single 
symbol > ปรับสีและขนาดตามท่ีตองการ > OK 
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 6.ปรับแตงขอมูลเสนแนวรองน้ำ คลิกขวาที่ตัวขอมูล ไปท่ี properties > Symbology > single 
symbol > ปรับสีและขนาดตามท่ีตองการ > OK 

 
 7.ปรับแตงขอมูลเสนแนวรองน้ำ คลิกขวาที่ตัวขอมูล ไปท่ี properties > Symbology > single 
symbol > จาก singl maeker เปน SVG Marker > เลือกรูปบานจากระบบ เปลี่ยนสี > OK 
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 8.ใสแผนที่พื้นหลัง ไปที่ Web > QuickMapServices > OSM > OSM Standard 

 
 >วาง Layers ขอมูลตามนี้ 
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 9.ทำแผนที่และใสองคประกอบของแผนที่ ไปที่ New Print Laout > ตั้งชื่อ > ใสแผนทีท่ี่ทำ ใส
องคประกอบของแผนที่ เชน ชื่อแผนท่ี ทิศ มาตราสวน พิกัด ขอบระวาง คำอธิบายสัญลักษณ ผูจัดทำ วันที่
ผลิตแผนที่ และ 3D Map (แผนท่ีเล็กๆดานบนขวาของแผนที่ในขอบระวาง)  

 
 ***แตเนื่องจากคอมพิวเตอรมีปญหาทางเทคนิค ทำใหไมสามารถสราง 3D Map เองได(สรางแลวไป
เปดในโปรแกรมเปดดูภาพ 3D ได แตไมแสดงใน QGIS) จึงใสแบบจำลองระดับสูงเชิงเลขท่ีเปนไฟลภาพแทน 
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Laboratory 5 
 

 

ชื่อภูมิศาสตร 

ขอบระวาง 

ทิศเหนือ 

ชื่อแผนท่ี 

แผนที่สวนเล็ก 

ตัวแผนที่ 

โลโกหนวยงานของ
ผูจัดทำแผนท่ี 

ชื่อผูจัดทำแผนท่ี มาตราสวนคำพูด วันท่ีผลิตแผนที่ คําอธิบายสัญลักษณ 

มาตราสวนบรรทัด 
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องคประกอบของแผนท่ี 
 1.ชื่อแผนที่ จัดวางไวตำแหนงกึ่งกลางดานบนของกระดาษ ตัวอักษรมีความหนาและขนาดใหญกวา
ขอมูลอื่นๆ เพ่ือใหแสดงความโดดเดนและใหเห็นชัด เลือกใชชื่อแผนท่ีที่มีความสัมพันธกับตัวของแผนท่ี 
 2.ทิศเหนือ จัดไวตำแหนงซายบนบริเวณท่ีไมมีขอมูลสำคัญในแผนที่ที่ตองการแสดง เพ่ือแสดงทิศทาง
และไมใหตัวของทิศบดบังขอมูลในแผนท่ี  
 3.แผนที่สวนเล็ก เลือกเปนแบบจำลองระดับสูงเชิงเลข เพื่อแสดงใหเห็นถึงลักษณะสูงต่ำของแผนท่ี 
แสดงรายละเอียดเพื่มเติมจากแผนท่ีหลัก จัดไวตำแหนงดานขวาบนของแผนที่ ซึ่งเปนตำแหนงที่ไมมีขอมูลของ
ตัวแผนที่ปรากฏ เพื่อไมใหบดบังตัวแผนที่ รวมถึงใหน้ำหนักของแผนท่ีถวงดุลกับทิศเหนืองที่อยูทางซาย 
 4.ตัวแผนที่ จัดวางไวตรงกลางหนากระดาษ เพื่อใหตัวแผนที่โดดเดนและสะดุดสายตาแกผูใชแผนท่ี 
ไมใหสวนประกอบของแผนท่ีสวนอื่น ๆ มาบดบัง เพื่อใหแสดงขอมูลของตัวแผนที่ไดอยางครบถวน  
 5.ชื่อภูมิศาสตร  คือขอความที่ใชอธิบายลักษณขอมูลของแผนที่ โดยในแผนที่นี้ชื่อภูมิศาสตรบงบอก
ถึงชื่อตำบลที่อยูในเขตรักษาพันธุสัตวปาเขาสอยดาว จัดวางไวบริเวณใกลเคียงหรืออยูในตัวแผนท่ีและขอบเขต
ตำบล เพ่ือความเขาใจท่ีถูกตอง 
 6.ขอบระวางและพิกัดกริด เปนกรอบของตัวแผนที่ เพ่ือแสดงตำแหนงพิกัดทางภูมิศาสตรของสถานที่
ในแผนที่นั้นวาอยู ณ ที่ใดบนโลกใบนี้ 
 7.มาตราสวนบรรทัด เพื่อแสดงอัตราสวนในแผนที่กับพื้นท่ีจริงวามีขนาดเทาใด  
 8.มาตราสวนคำพูด เพ่ือแสดงอัตราสวนในแผนที่กับพื้นท่ีจริงวามีขนาดเทาใด 
 9.คำอธิบายสัญลักษณ จัดวางไวดานซายลางของแผนที่ เพื ่อแสดงคำอธิบายเพิ ่มเติมเกี ่ยวกับ
สัญลักษณในแผนที่ที่อาจจะดูไมเขาใจในชวงแรก แตเมื่ออานคำอธิบายสัญลักษณก็จะเขาใจมากย่ิงขึ้น 
 10.วันที่ผลิตแผนที่ จัดวางไวตรงกึ่งกลางดานลางของตัวแผนที่ เนื่องจากอยูนอกของระวางและตัว
แผนที่ทำใหไมปดบังตัวแผนที่ เพ่ือแสดงวันที่ผลิตแผนที่และ 
 11.ชื่อผูจัดทำแผนที่และหนวยงานที่จัดทำ จัดวางไวบริเวณขวาลางของแผนที่ เพื่อแสดงชื่อบุคคล
หรือหนวยงานผูจัดทำแผนท่ี 
 12.โลโกของหนวยงานที่จัดทำแผนที่ จัดวางไวบริเวณขวาลางของแผนที่ เพื่อแสดงสัญลักษณของ
หนวยงานผูจัดทำแผนที่ 
 13.พื้นหลังของแผนที่ เพื่อเพื่อแสดงใหเห็นถึงที่ตั้งสัมพันธของแผนที่วามีลักษณะอยางไร แสดงพื้นท่ี
โดยรอบ และเนนใหแผนที่มีความโดดเดน นาสนใจมากย่ิงขึ้น  
 
 
 
 
 
 
 
 
 
 
 


